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Adding People to Your Tree  

In the People Workspace a new family pedigree screen appears.  This area has two sections 
accessed from the following tabs:  

1. Family  
2.  Person  

 
People Workspace Family Tab 
Most of your time will spent in the family tab as you add more family names.  There are four 
main sections in this screen:  
 
1. Individual Index (on the left) - In the Index panel, users can select each individual quickly by 

using the scroll bar or enter the individual’s name in the Find search box feature. A filter 
option allows users to filter individuals in this panel such as females, ancestors, 
descendants, exclude single individuals or their families, or even filter by vital facts, or other 
facts.  

2. Pedigree View (in the center) - The pedigree tree shows a list of relatives that can be moved 
to the left to see the descendants or to the right to see the ancestors by selecting the left or 
right arrows at either end of the tree chart. Users can select any name to see a pop-up chart 
of the vital stats of that ancestor. 

3. Family Group View (at the bottom) - where the children are listed. 
4. Editing Panel (on the right) - In the editing panel on the right, users enter more detailed 

information or modify on the vital stats in the blank spaces. Users can Customize the panel 
with your choices of facts that you want displayed inside the panel. A new options box 
appears with many facts to be displayed. 

 
 At the top right, users can Add new relatives such as parents, spouses, children, or even 
unrelated persons, Delete the indicated ancestor in the screen if necessary, but be careful doing 
this step. It will ask you to confirm this action as a safety step. You can also Print different 
charts, family group sheets, genealogy reports, photo albums, and a relationship chart. And 
users can Share the family tree information, convert to different formats including PDF and 
email the different charts to a relative, and export the same information to a CD or as a file to 
email to a relative.  

1. Adding multiple spouses to any ancestor is easy by selecting the Souse icon. A new text box 
appears, then select the gender and OK, then add the spouse info in the editing panel on 
the right side. Users can select which spouse is preferred on the screen by selecting the 
Spouse icon button, providing two or more spouses are listed, then select the preferred 
individual, then check the Preferred Spouse box.  

2. Deleting children is easy by right click on the child’s name and select Delete child, but be 
careful as it deletes this person entirely form the family file. If you meant to detach this 
child from either parent, then select the Person menu item at the top, then select Attach/ 
Detach Child. Add or detach child from either parent with the pop up menu item.  
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3. Sorting children by birth order is easy by selecting the rotate icon to the right of the 
marriage information.  

4. Users can also Bookmark certain individuals that are often used in your family tree. Once 
bookmarked, they will easily be available in the same index window for easy access. The 
History button allows users to view the most recent individuals you have edited. 

 
Editing Panel 
Select the name or blank button in the Pedigree chart to add new names. Add the primary facts 
in the editing panel. Dates can be entered in any format, but will be displayed, ie, 12 Feb 1910, 
only in a certain format that you specified in Options in the Tools menu. Tip: Use backslashes on 
long surnames, otherwise FTM will only recognize the last word of the surname. Example: \Van 
Der Voort\ or \de la Vega\ as used by many Europeans. Tip: Enter city or town or township, 
county, state and country for locations in the U.S. ranging from smallest to largest location in 
any field. For foreign locations, enter city or town, parish or district, province, and country. 
Fastfields is a special feature that saves time in typing repetitive names, but sometimes can be 
tricky, so watch what you’re typing as a different similar repetitive name may appear.  
 
People Workspace Person Tab 
The Person Tab in the People workspace allows users to view four new panels: Facts, Notes, 
Media, Tasks, and Sources items 

1. Adding Facts is easy and similar to the past versions. Select Facts (if necessary) at the top of 
this panel, select the plus (+) sign to add a fact. A pull down menu of different facts 
appears. Scroll down to the preferred one and highlight it, then select the OK button. For 
certain facts like Social Security number, enter in the far right panel.  

a. You can add a source citation for this fact in the Source panel by selecting the 
New button and completing the required information. A new text box appears, 
thus allowing users to complete the source citation.  

b. For custom Facts, either select the New button in the Add Facts text box, then 
add the custom Fact. If users have similar facts for similar events, you can 
change the priority of those facts by selecting Preferred using the Options 
button in the editing panel.  

c. Changing relationships is easy by selecting the Relationships button in the upper 
right side of this panel. In the editing panel on the right side, select the pull 
down menu and select the desired relationship. 
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2. The Notes Panel for adding biographies for the ancestor, research notes, legends, etc. 
Users can add about 200 printed note pages per ancestor. A memory gauge in the upper 
right side of this panel lets users know how much space has been used. Users also have two 
separate note pads available: Personal notes for biographies and Research notes for just 
that. You can mark either notes as Private by selecting the lock icon. Tip: The Copy and 
Paste functions work in notes if importing information from another external document. 
Users have the ability to change the font size by moving the variable scale at the far right 
and color, use bold, italicize, or underline features with symbols in the notes text including 
a custom spell checker.  

3. Adding Media is easy by either linking to an existing picture in your computer or making a 
copy, which takes more family file memory.  

4. Tasks can be added using the Tasks tab 

Menu Edit 
As in past FTM versions and all Windows based applications, the Edit menu is similar to other 
programs. The standard features of the edit menu include Undo, Redo, Cut, Copy, Paste, 
Delete, & Select All.  
 
1. Insert Symbol allows users to add different accents for different letters of varying 

languages. There are shortcut keys for users if lots of repetition is used for any of these 
special tools. The shortcut keys are listed in the different menu items.  

2. Edit Person allows users to modify facts of any individual. 
3. Find Duplicate People (New Feature), allows users to locate the same or similar names, 

especially if merging two family files. This is helpful to eliminate the same people from 
another family file.  

4. Find Individual does exactly that, providing you have the person’s name in your family file. 
A text box appears with the name that you specified and shows all locations for that 
particular name in your family file. Alternately, users can go to the Index of Individuals to 
locate the same person.  

5. Find and Replace allows users to search for a particular word or phrase and replace it with 
your preferred word or phrase in the case of misspelled names or words.  

6. Manage Facts allows users to add, delete, or modify any fact in the available facts list.  
7. Manage Sources allows users to add, edit, replace, and delete source citations located in 

the Master Source file.  
8. Manage Repositories allows users to add, edit, replace, or delete research repositories 

such as county courthouses, libraries, etc. 
 
Menu View 
The View Menu allows users to move forward to the next screen or back to the previous 
screen. Also the seven workspace tabs can be accessed here, but faster access is utilized by 
using the tabs at the top of FTM. There are shortcut keys for the tabs as listed in the View 
menu item. 
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Menu Tools 
The Tools menu allows users to have access to several useful tools that were part of previous 
versions of FTM.  
 
1. Date Calculator - Can give any date if the birth date, death date, or other special date is 

known. Select the preferred item required. If the birth date is already recorded for any 
ancestor, users can find the age for any event time by completing the special event, such as 
a marriage date. Other dates can be found by providing two of the three required fields of 
information. 

2. Relationship Calculator - Determines the relationship between any individual in your 
family. 

3. Soundex Calculator - A helpful tool for determining the Soundex value for any surname. 
Soundex is used with many older documents created by the U.S Government. Inserting a 
surname in the Name field will yield the Soundex value. Soundex is a method of coding 
names with unique numbers based on the way the names sound—not on their spelling. 
Soundex was used for several U.S. census reports and passenger lists to help users find 
surnames based on similar sounds. Obviously, the census or passenger list record takers 
misspelled many names due to the sounds of the ancestor names taken at the time. 
Soundex is a great method to locate many of those misspelled names of ancestors. 

4. Resolve All Place Names (New Feature) - Users can Resolve All Place Names by selecting 
this menu item. Users can correct location names that are not found in the Family Tree 
Maker database. You can correct the name so it is spelled correctly and in a consistent 
format throughout your tree file or have Family Tree Maker accept the place name as you 
entered it. Users have several options to modify the information or leave as is. 

5. Convert Names (New Feature) - Users can convert all names to different text styles such as:  
mixed-case or mixed-case with capitalized surnames. 

6. Compact Files - Compacting Files may be required as users keep adding to the family file. 
The file size will increase with more names being added. It’s recommended to compact 
family files every six months, if more than several hundred names are added every six 
months. The compact process will make FTM software operate faster and smoother in 
operation. Compacting the file may take several minutes, depending on the size of your 
tree file. It’s recommended to backup the main family file before compacting. 

7. User Information - Users have the option to complete their personal contact information 
for insertion into the many different reports. Users may want to use it so relatives will know 
how to contact the author of the reports for additional copies or for corrections. 

8. Plugins - Users have the capability to add external Plugins to FTM software for 
enhancement features provided by third party software vendors. To date, no plugins are 
available, but probably will soon be available. 

9. Options - Users can change system settings for the FTM software. Besides the standard 
settings for changing file directories for new trees, fastfields, spelling, FTM has options on 
dates and names, and multiple warning alerts. 
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Sources 
Documenting sources are important for several reasons. First, sources validate your genealogy 
and family history research. Second, if you share your genealogy with other family members, 
they will know that your research is accurate, and last, sources can help organize your research 
work. 
 
FTM creates both Master Sources and source citations. Master sources are facts about an 
ancestor that can be repeated for many source citations used for different events and different 
individuals. Source citations are the individual details for a fact of any ancestor, i.e., Info 
recorded in a record book by any government entity. 
 
1. Add New Source Citation - There are several methods to start a Master Source.  

a. Selecting the People workspace, then select either family or person tabs, then 
select the source icon in the editing panel on the right side of the screen. The 
editing panel may need to be expanded if it doesn’t show on the screen. Then 
select Add New Source Citation. 

b. Add the name of the document using a specific ancestor name as similar 
documents will be used in Master Sources that can be duplicated for other 
family members as required. 

c. Users can add the citation detail about the location of the document, i.e., County 
ŎƻǳǊǘƘƻǳǎŜΣ ŦŀƳƛƭȅ ƳŜƳōŜǊΩǎ ƘƻƳŜΣ ŜǘŎΦ 

d. Citation text would include document summary details. No need to copy the 
entire document text, but briefly summarize.  

e. Users can copy the citation information into Reference Notes, which can be 
made available in family group sheets and many genealogy reports. 

f. Users can import the scanned document or online database image directly into 
the Media section of the source citation by selecting that tab and follow the 
instruction outlined in the Help button. The scanned document or image must be 
imported into the master media file so that an internal link can be associated 
with the source citation. Another method is to use the Web Merge Wizard to 
import the image directly from Ancestry.  

g. Users can add more detailed information in the source citation as required. 
h. Users can add more source citations or edit the existing ones as necessary. 
i. Users can copy the contents of the text for later use into another citation. 
j. A new feature of the citation tool is the repository location, which can be used 

instead of the citation detail if there are a lot of documents that came form the 
same source, such as a family member, county courthouse, online database, or 
library. To add a new repository, select Edit menu, Manage Repositories, and 
select New. Complete the new repository information and select OK. 
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k. Select the OK button to complete the source citation. Once the Master Source 
has been established, another family member can use the same source citation if 
it applies.  The handy source wizard tool gives users the ability to enter the 
correct source information based upon Elizabeth Shown Mills book, Evidence 
Explained:  Citing History Sources from Artifacts to Cyberspace. It is 
recommended following the wizard format, so you can get into the habit of 
adding source information for each new Fact or document. 
 

Citation Rating System 
Another new feature of the Master Sources is their rating system, which allows users to give a 
rating of the source, list it as original or derivative, and type of evidence. 
 
1. Manually rate the document quality or 
2. Let FTM rate it automatically by completing the different quality measurement buttons.  

a. To open the source rating system, select the Sources workspace, select the 
preferred source from the list on the left side, then select the link at the bottom 
center, then select the person’s name, then finally select the star icon above the 
name(s). 

b. Review each of the categories and rate them accordingly. The highest rating is 4 
stars, which indicates users have the original clear document and is considered 
primary or direct evidence. 

c. Users can add the justification by indicating more information about the 
document as necessary. 

This is a nice rating feature, if properly used, can help users organize their sources. 
 
Using Maps to Search for Ancestor Locations  
In FTM 2009, a map migration feature has been included for users to print a map with 
migration paths of their ancestors. FTM partnered with Microsoft Virtual Earth© maps feature 
to illustrate stunning and colorful maps all over the world. Satellite imagery is also shown for 
selected regions of the world including the United States, United Kingdom, Canada, and 
Australia. More satellite imagery will be included over time without the need for special 
downloads to your computer.  
 
1. ¢ƘŜ .ƛǊŘΩǎ 9ȅŜ ǾƛŜǿ shows closeup details of your ancestor’s home. The satellite images are 

not live, but taken several to many months ago. The map feature uses the Internet to 
generate the latest map databases. Because of this feature, it takes several seconds to 
download the selected map to your FTM software. 
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2. The Places Workspaces shows different maps in second or third dimensional views, road 
map view, or satellite or bird’s eye views.  

a. Users can select which map is preferred from the list of place locations listed in 
the left collapsible panel. The map feature will access the Internet and display 
the second dimensional road map view to validate your ancestor’s location. 
Users can navigate the road map by selecting navigate wheel or drag or move 
the map any direction using the mouse. 

b. Users can zoom in or out on any selected map by selecting the plus or minus 
signs. 

c. Users can see third dimensional, satellite or bird’s eye view. The Bird’s Eye view 
will not be available for all areas in the United States or the world, even though 
the satellite view will show most of these areas. 

d. The Places lists the different family members who live at the selected map 
location, based upon your data input. If you didn’t list the location for some 
relatives, no map will be shown for them. To add more map locations requires 
users to add more ancestor locations to the main People workspace. 

e. Users can type in cemetery in the location field to locate the closest cemetery or 
other preferred place in that area. 
 

3. View and Print Migration Maps of Ancestors - Are you interested in knowing where your 
ancestor started his journey and finally landed before his death? This is a new feature of 
FTM 2009 and has the ability to track each ancestor, providing you listed the different 
location Facts with dates about that ancestor, i.e., Birth, Marriage, Death and other details 
of his movements. 

 
a. Users can show a detailed ancestor migration map of the different locations either on a 

worldwide map or just the United States.  
b. Select the Places workspace, then select the Person list by category in the left panel, 

then select the family member in the list. The map will download with migration lines 
between each location you have listed in your Facts list. Users can verify the migration 
route by reviewing all the different locations in the ancestor’s places listing in the right 
panel. 

c. Users can print the map or include into a genealogy report or book. Users can only print 
second or third dimensional and satellite views of any map, but not the bird’s eye view. 

d. There is a location resolution feature that alerts users about similar locations that may 
be misspelled. Users can make corrections to place names in case misspelling places 
occur. Users can manually review the place names by selecting Tools, Resolve All Place 
Names. 
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Using Web Search 
FTM has the ability to research your ancestors online using different databases.  The Web 
Search feature utilizes www.ancestry.com databases for researching ancestors. To do so 
requires registering with FTM, a subscription to Ancestry, and an Internet connection. This is 
one of the key features of FTM that no other genealogy software has. However, the web search 
feature can be disabled by selecting offline in the File menu if required.  Users can import the 
image and source information for any ancestor directly into their family tree in FTM from their 
email account. FTM has a nice feature to let users know if Ancestry has located any results for 
each ancestor by looking at the pedigree chart selecting the Family tab in the People 
workspace.  
 

1. A green leaf will appear next to each name that Ancestry has found any results. This 
isn’t foolproof as the results seem to pick only 5 star rated results, thus several lower 
rated results could be missed. To resolve this, a New Search can be done. More results 
will occur upon doing this extra step. 

  
2. By placing the mouse over the name, a pop-up box appears to show how many hints 

(results) will be available. The results indicate how many records and tree might be 
available for that ancestor. Tip: Be careful on importing information existing family 
trees. Many submitters don’t validate their family trees as they may have copied them 
from other researchers. Too much copying of family trees occurs online without any 
verification. 
 

3. Simply click on the Ancestry hints to find what records are available. FTM automatically 
changes the screen to Web Search and starts a database search for the ancestor. A 
search screen appears with the results from Ancestry. 

 
As in previous FTM versions back to 2005, the database records for the selected ancestor will 
appear in the center panel. Your ancestor’s facts will be displayed in the lower left panel. The 
search results information will be displayed in the lower right panel. If the information is a 
match to the ancestor, users have the option to select the Merge icon or select the Ignore 
(stop) icon. If the source matches a different person, users have the option to select a different 
person by selecting this icon. A New Search may be required to gain more results by selecting 
this button.  
 
A new screen allows users to vary the ancestor’s information to narrow or widen the results. 
After finding the correct results, users have the option to compare the results in a new screen, 
comparing the known facts with the possible results data and marking the data as the new 
preference or just keep as an alternate source or discard the new data.  
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Merging Results into Family Tree - The next step is to review the merged information using the 
Web Merge Wizard.  

1. Both the preferred and alternate data will be shown for the ancestor’s information.  
2. Users can review the source information as noted below and add the document image 

by checking the Media box below.  
3. If source editing is required for the source citation, then select the Edit button and 

follow the prompts for editing.  
4. If satisfactory, then select the Merge Now button or select Cancel if the data is not 

satisfactory. 
 

Creating Trees and Charts 
There are a number of charts available in FTM 2009. As an example, there are Pedigree, 
Descendant, Hourglass, Bow Tie, Fan, Family Tree, and Relationship charts and much more. 
The charts can be done in horizontal or vertical layout. More charts than anyone really needs, 
but you have a wide choice to choose from. 
 
 Lots of various options can be shown for each chart including different fonts and sizes, colors, 
photos, adding borders, etc.  It is recommend to keep it simple with the BMD info only and add 
a desired photo for each individual. Don’t add too much info for each individual as the chart or 
tree will be too crowded. Select the Publish workspace at the top, then select the preferred 
chart in the center panel, then select the various options in the right panel and finally select the 
‘Create Chart’ button. Users can use the same process for the different charts or trees. 
 
Customizing Charts - Customizing any of these charts is easy to do. Basically select the 
preferred chart, then select the editing tool to select various items to include in each 
individual’s box. Adding photos is also easy by selecting either thumbnail or standard photos for 
each individual.  Items to consider adding would be the BMD information such as dates and 
locations. But as mentioned previously, don’t make each ancestor box too crowded. You can 
add borders and other items as well. 
 
Saving and Printing Charts or Trees - Saving the charts and tress is simple by selecting the save 
icon in the editing panel on the right. Users can print the charts or trees by selecting the 
printing icon at the top. 


